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Introduction

Introduction

There are a number of ways in which you can optimise media for running on DeltaServer, in order to
get the best performance from your servers.

Ø Distributed File Manager  (DFM) provides the means to convert compressed file formats into
STH/7TH frame formats. 

Ø Delta Content Protection System  (CPS) offers both encryption, and playback restriction to
venues and time windows.

Ø 7th and sth Plugins for Adobe CC and Nuke enable movie compositions to be saved directly into
7TH/STH format.

Ø 7thMovieViewer  : view 7TH / STH, TGA and DPX movie files frame by frame.

Ø 7thFileVerifier  checks a folder of movie frame files to test validity against several variable
parameters.

Ø Carving Media for Dome Displays  : divide media up to only the area required for each channel.

Ø BackPack Media Distribution  is used to distribute files and folders to Delta Media Servers via
the DeltaMonitor application resident on each server.

18
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100
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120



Basic Requirements for Media Shows



8

MC256-9 Managing Media for Delta : User Guide 
 
                                                                                                       © 2024 7thSense

Basic Requirements for Media Shows

Basic Requirements for Media Shows

As initial guidance, this section provides a brief overview of media formats and other requirements
that enable smooth running of Delta shows.

Movie Formats (E:\Movies)

Movies are typically held on the E:\ drive.

A movie consists of a single folder full of files, where each frame of the movie is a separate file.

You can load movies onto the server via the ‘Movie Drive’ Windows Share, or locally via a Windows-
formatted USB external hard drive (USB3 is supported).

Note: TGA files should be placed in a single folder within the Movies folder of the Delta Media Server
movie drive and named with a constant number of digits between 4 and 12 digits long,
preceded by an underscore like this:
…
my_movie_000008.tga
my_movie_000009.tga
my_movie_000010.tga
my_movie_000011.tga
…

· The frame number must be the last set of characters in the filename before the extension.

· If files are incorrectly named (or have fewer than 4 digits or greater than 12) there will be no
output (playback will be black).

Ø See the Delta Workflow Guide for more detailed information about Delta media storage
requirements. 

Movie file dimensions in Delta

Movie dimensions matter. On older versions of Delta odd sizes may not run or run badly. From Delta
2.6.74 bad dimensions will generate an alert in the Resource Pool. Please be aware of these
requirements:

4:2:2 8-bit must have a width divisible by 2

4:2:2 10-bit 7th (not DPX) must have a width divisible by 8

4:2:0 8-bit must have a width and height divisible by 2

http://portal.7thsense.one/user-guides/M084-delta-workflow-guide/
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YCoCg must have a width and height divisible by 4

Movie file formats supported in Delta

TGA sequences – or 7TH (STH) (preferred)
24 bit RGB or 32 bit RGBA (8 bit per colour)
RLE lossless compression is optional (resolution / performance limits apply to RLE)
RGB colour space

DPX
From Delta 2.6, .dpx formats have been more reliably supported:
8-bit (4:4:4)
10-bit (YUV and 4:4:4)
12-bit (4:4:4)
full support of little- and big-endian
filled and packed types are both supported.
8- and 10-bit RGBA 4:4:4 is supported from Delta 2.7.
HDR is supported from Delta 2.7 build 7.

A7S / CIN / SGI / YUV
30 bit RGB (10 bit per colour) / 8 bit possible
RGB or XYZ colour space

JPG, JPG2000, BMP, TIFF, PNG
Image sequences cannot be played, but can be recorded (sliced / carved) from Delta or DFM
utility.

7th420, 7th422, 7th444
Created by DFM or recording from Delta (Note – enable Optimize for SSD)
7th444 is completely lossless; 8-, 10- or 12-bit
7th422 is in YUV colour space, 33% space saved on disk
7th420 is YUV colour space, 50% space saved on disk

Codec filetypes (MXF, MOV, MP4, LXF, ASF, WMV, DV, MPEG-PS, MPEG-TS, GXF, FLV,
AVI, MKV, WebM, HapQ, 7thHapQS) are all supported from Delta 2.5
With codec movie formats, the audio is in-built and speaker mapping is encoded in the file itself,
so Delta audio control available is therefore only volume control (no channel mapping as is
possible with separate audio files – see audio files below).

Note: codecs are supported for media prototyping type purposes only, and are never
recommended as the final deliverable/show content.

Since codec playback in Delta is CPU-based, this typically allows only 1-2 movies at HD 60p or
equivalent resolutions. For anything more, codec movies should be converted to image
sequences using Distributed File Manager .18
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NotchLC is a Luma & Chroma (YUV) codec that achieves compression rates between 5:1 and
8:1 with minimal perceived quality loss, and is suitable for very large canvases. From Delta 2.8,
NotchLC codec in .mov wrappers can be played, but note that audio is not enabled in this
format. If exporting from Adobe Media Encoder, first deselect ‘Export Audio’. 
NotchLC is best converted to uncompressed frames using: NotchLC to NotchLC7th  utility.

A Note on Using Codecs (not recommended for final show content)

Consider the reality of codec (mp4, .mov etc.) playback on Delta servers. Although Delta software can
now play these movies they are not optimised for this workflow. Uncompressed movies in the .7th
format are a very reliable method of playback, as the files stay the same size, and are standardised,
meaning they are very stable and predictable.

Codec movies (.mov, mp4. h264 etc.) come in many types, with different settings, bit rates and sizes.
These variances makes it very difficult to predict server performance and stability, as the CPU
overhead of the movie tends to fluctuate depending on the content.

Although a server can play a 3840 × 2160@60 fps movie perfectly in .7th format, this does not mean
you will get the same result with a .h264 movie of the same resolution/refresh rate. When using
codec you will need to do much more stability testing before a show to ensure playback is solid. This
difference is due to the high CPU demand of codec movies. In contrast, uncompressed movie
playback requires very little CPU at all, instead being processed on the GPU. (Note: video capture is
also a high CPU task.)

If you intend to play codec movies rather than converting to .7th using DFM, you need to test the
particular codec(s) (and settings) thoroughly. This testing should be conducted with the server fully
loaded, driving all displays and captures.

For a stable and predictable codec workflow, use a professional conversion software to create your
own customised and proven preset .mov or h264/5, then convert new movies using that profile,
before playing them on the server. This will minimise playback issues, and reduce the need to
thoroughly test each new movie.

Movie Guidelines – Will it Play?

The playback capability of servers is set by the disk and graphics configuration specified. Typically
each server is configured to meet the customer requirements, playing fully uncompressed 4:4:4
unless otherwise specified.

Typical playback rates for common resolutions in 4:4:4
1080p30 = 180 MB/s
4k30fps = 760 MB/s
4k60fps = 1.52 GB/s
8k30fps = 3 GB/s

16
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Delta Family Typical Playback

NanoSDI-1: 1 × 3G-SDI output used as HD30 or 60p or 1 × 2K 30p compressed or 1 × 2K 30p
uncompressed* or 1 × 2K 60p uncompressed* 

NanoSDI-4K: 1 × 6G-SDI output used as 4K 30p SDI or 1 × 2K 30p or 1 × 4K 30p (upgradable to 12G-
SDI output**: up to 1 × 4K 60p 4:2:2 uncompressed*)

* Disk upgrade required
** AES Audio not available for 12G

Nano-1: 1 × HD (1920 × 1080), WUXGA (1920 × 1200) or 2K (2048 × 1080) 30fps in 4:4:4

Nano-2: 2 × HD, WUXGA or 2K 30fps in 4:4:4

Nano-3: 3 × HD, WUXGA or 2K 30fps in 4:4:4

Nano4K: 1 × WUXGA or 2K 30fps or 4K 24fps

Proton: 5 × HD, WUXGA or 2K 30fps in 4:4:4

Nucleus: 2 × 4K 30fps in 4:4:4

Infinity: up to 8K × 4K 60fps 10 bit in 4:4:4

Playback of 2 layers of 2 × 1080p30 equates to 4 × 1080p simultaneously, which would specify the
Delta Proton model as minimum, as the smaller units would not manage these requirements.

Movies can be any aspect ratio (example 12000 × 1080, 3200 × 3200) to best fit the resultant
resolution of the display surface.

Movie Guidelines – Carving / Slicing

Up to Disk and Graphics limit – don’t carve, just copy to all servers and they ‘look’ at the right part in
real-time.

Above disk limit, carve via DFM or Delta recording to create server-specific portion or channel mapped
media or choose 7TH422 or 7TH420 or reduce resolution.

Will it fit on the server?

Servers are specified to meet user media size requirements. Some examples of available movie disk
space:
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900 GB SSD RAID0 (4 × 240 GB disks) = 850 GB safe free space

HD 444 30fps = 178 MB/s, so 850 / 0.178 = 4775s = 79 minutes at this resolution and frame-rate

Nano 225 GB : 205 GB free = 19 minutes of 1920 × 1080 4:4:4 30 fps

Nano-2 450 GB: 424 GB free = 20 minutes of 3840 × 1080 4:4:4 30 fps

Nucleus 900 GB : 850 GB free = 20 minutes of 7680 × 1080 4:4:4 30 fps

Infinity : 1800 GB : 1695 GB free = 18.5 minutes of 4096 × 2160 4:4:4 60 fps

Ø File Size versus ‘Size on Disk’: know the differences and why. 

Usable disk capacity is not the number on the label

The raw capacity of an SSD (what it says on the box) can be 120 GB, 240 GB, 480 GB, 960 GB,
1920 GB, or 3840 GB. Part of this capacity is used for necessary overhead associated with
partitioning and formatting. The result is that about 95% of the raw capacity is usable. For example,
2 × 120 GB raw disks would give around 225 GB formatted array. Beyond that, we only recommend
utilizing about 95% of the available formatted capacity, because for many disk models, it is valuable
for the disk’s firmware to have some some breathing room for activities that aid in the longevity of
the disk’s lifespan. So for example, we would recommend filling only about 214 GB of that
formatted volume of around 225 GB.

Image Formats (Typically C:\Images)

JPG, JPEG2000, BMP, DPX, PSD, TIF, TGA, PNG, GIF, A7S. From Delta 2.7 build 7: DPX 2.0HDR.

PNG, TIFF and TGA can have 8-bit alpha plane

Up to 1920 × 1200 in size (Nano-1)

Up to 8192 × 8192 in size (Nano-2, Nano-3)

Up to 16384 × 16384 in size (Nucleus / Infinity)

Image sizes add up and will fill up RAM (normal Mode) – see Dynamic Image Loading

Audio Formats (Typically C:\Audio)

Mono WAV preferred

Can adjust Speaker Mapping for Mono files

http://portal.7thsense.one/user-guides/M484-filesizes-in-windows/
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Stereo, 5.1 and 7.1 also played

Note a 2 GB file size limit for WAV files

Can also play MP3, AIFF

Can adjust frame-rate compensation if required

Live Capture

Any Direct Show Compliant Capture Device

1 – 12 DVI Inputs (auto-detect most PC formats)

2 – 8 SDI inputs (manual HD format selection)

Composite, sVideo, Webcams

No HDCP available (DVD or BluRay players)

Number of possible inputs dependent on free slots in the server

Number of onscreen live inputs dependent on overall load (other content, graphics resolution)

Can ChromaKey, warp, position etc

Some capture cards can spoof DVI EDID: example is 3000 × 3000 30 Hz input

General Usage – Visual Media

For fullscreen media, match the size to the display canvas size.

Wrong size media means poor aspect ratio, fat or thin people!

Content should be supplied full size, do not let content creators carve it up, apply geometry or blends,
or create overlap – Delta does all that.





NotchLC to NotchLC7th
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NotchLC to NotchLC7th

NotchLC to NotchLC7th

NotchLC when in a .mov wrapper has LZ4 compression within it. This compression utilises the CPU
and therefore it takes longer to process a frame. By removing the LZ4 compression we can optimise
the performance of the system for NotchLC playback.

A small utility called ‘NotchLCto7th.exe’ is Installed with Delta 2.8.7 and resides in: C:
\Program Files\7thSense\Delta\Utilities\NotchLCTo7th.

The NotchLC to NotchLC7th tool:

· keeps the media as NotchLC format

· removes the LZ4 compression and .mov wrapper

· converts the .mov into an image sequence of .7th frames.

Run NotchLCto7th.exe in a command window with the following arguments:

Command Line Argument explanation

-in=SourceMovFileIncPath Absolute path to the NotchLC codec to unwrap

-out=Target7thStubIncPath Path to a folder where the unwrapped frames will be output

Example:

NotchLCTo7th -in=c:\Movies\MyNotchLCFile.mov -out=c:\Movies\7th\MyNotchLC7th

Notes

· Use backslashes ('\') as the separator between folder names, as this is required for Windows
paths.

· Use quotes to enclose paths with spaces: "C:\Movies\Folder with Space\MyNotchLC7th".

· Delta Media Server does not support embedded audio within the NotchLC .mov file. The NotchLC
to NotchLC7th converter does not support embedded audio either.



Distributed File Manager



18

MC256-9 Managing Media for Delta : User Guide 
 
                                                                                                       © 2024 7thSense

Distributed File Manager

Distributed File Manager

DFM (Distributed File Manager) is a single utility used to manage media for the Delta Media Server
system. It is available in 32 bit and 64 bit versions for Microsoft Windows.

DFM can extract movie frames and audio from a compressed file format, into sequences of individual
frames.

See also: 7th and sth Plugins for Adobe CC and Nuke
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Distributed File Manager

Installation: 32 vs 64 Bit

DFM can be demanding, and requires a minimum of four processing cores. Check in Windows Task
Manager:

Install ‘As Administrator’:
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Distributed File Manager

· 7thSense recommends that you install the 64 bit version of DFM if possible.

· 7thSense filters and the DFM application are available in both 32 bit and 64 bit versions.

· 32 bit DFM can be installed on 32 and 64 bit versions of Windows 7.
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Distributed File Manager

DFM Defaults

The first time DFM is launched, a defaults dialog will appear, as shown below. To revisit this dialog,
see Settings > Conversion Defaults.

Most Delta media systems operate with a consistent file format and media location. The options
selected will be the default selections from this point on for all new media added into DFM for
extraction.

Note that the output format ‘7th 6to1’ is legacy and whilst it will play, should now be avoided.

Optimize Conversions for SSD disks checkbox
Unchecked for HDD storage: movie frames are stored 10 per file
Checked for SSD storage: movie frames are stored individually – 1 frame per file

Output .sth files (instead of .7th)
Avoid the numeric file extension: for Nuke users.

Zip compress output .7th or .sth files
Apply internal colour-bit compression. This saves on file size, but will demand more CPU on
playing.

Select the correct Movie drive
Delta servers: For optimal functionality, we recommend that movies are stored on your server’s
E:\ drive, whilst all other images, sounds etc. are stored on the C:\ drive. Users of DeltaOffline or
working on a separate PC, may need movies to go to their local C:\ drive.

https://portal.7thsense.one/user-guides/M310-delta2_6-user-guide/part_3_deltaoffline.html
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Distributed File Manager

It is possible to override this for each independent media file in DFM on an individual file basis as
necessary.

When you open DFM, the initial screen will look like this:

Toolbar

The toolbar is detachable to float or be redocked at the side, and reset from the Windows title bar:
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Distributed File Manager

The buttons, in order: add media to the list, remove media from the list, view conversion log, and
monitor frames during conversion.

Control bar

The control bar is shown here during conversion, showing progress, and offering Pause and Stop.

File Menu

The list of items to convert and their settings can be saved to a .DFM file, and reused.

New
Clear the current list and settings.

Open
Open a saved media list and settings file.

Save As
If the current list and settings are based on a saved .DFM file but edited, save the new list and
settings.

File Extraction and Conversion

DFM can take movie files or sequences of images in a variety of formats and convert these to the
7TH, 7TH 420, 7TH 422, 7TH 444 proprietary file formats. These file formats feature various levels of
compression allowing high-resolution movies to be streamed from disk in real-time: Movie images
can be resized, cropped and scaled during this process if required.
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Distributed File Manager

DFM will also process audio files, whether contained within a movie file or in a separate audio file,
such as an mp3 file. Audio is split out into separate mono files for each channel suitable for import
into Delta media server.

If your computer has a codec to support the movie or audio files you want to convert, DFM can
convert your files.

With DFM version 2 and beyond, batch processing is supported. Multiple files can be queued up ready
for conversion.

The process can take some time, depending on hardware capability and movie size.
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Distributed File Manager

Extract a Movie

You can convert bitmap sequences or HapQ, MPG, AVI or WMV files to the 7TH (STH) file formats.
Audio files, such as mp3 files are also supported. Follow these basic instructions; for more detail, see
the sections on the [Basic Tab ], [Advanced Tab ] and [Audio ].

Ø Add Media to Extract  

Ø Extract Audio

Ø Selective Extraction and Conversion (Advanced Tab)

Ø Run conversion

Add Media to Extract

Click the add media button on the toolbar to add input files (movies) to the queue. If selecting an
image sequence, any file in the sequence can be selected.

The [Basic Video/Image] tab shows the selections that you made in the initial setup. Check and
amend as necessary. If required, click to select to extract the video/image sequence from this file:

31 33 38

25

26

27

28
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· Select your output format and check/uncheck Optimize for SSD (according to your storage device
– all SSD-based servers should have this checked).

· Additional compression is available by selecting the zip option. This format is lossless, and
reduces file size, but will increase CPU demand on playback.

· Tick Output .sth if you want this file extension (it is the same format as .7th).

· Update the output folder location if necessary. A new folder will be created if required.

· Update the output file name if required.

· Resolve any warnings.

Extract Audio

If the file contains audio, select whether to extract audio from this file. Update the file stub name and
output folder as required:
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Distributed File Manager

Selective Extraction and Conversion (Advanced Tab)

If extracting a video or image sequence, the advanced tab provides the ability to select a section of
the image sequence to convert, select an area of the file to convert, and choose the output size of the
file to convert to. It is also possible to select a range of input frames to convert and choose the output
number to start at.

An option to skip every other frame is available for advanced users who are using SSD storage. This
can be used for de-multiplexing stereo movies or halving the frame rate of images sequences.

Encryption

If converting a video or image sequence, encryption can be added to the output image sequence.

This feature is only available with a 7th Encryption licence.

Ø Encryption Option  35
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Run conversion

For a small preview of frames through the conversion process, click the monitor toolbar icon before
converting:
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Distributed File Manager

Add more media as required and click the green Convert button. The Pause and Stop buttons
become active until conversion is complete. Progress bars for Total and Current track the progress of
the conversion. Other controls are deactivated, but the log can be viewed.
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Distributed File Manager

Once complete, the Convert button will be reactivated, whilst Stop and Pause buttons are greyed out.
The image files will have been converted; check the destination movie drive to view the new file set.
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Distributed File Manager

Basic Tab

Output Formats

Select the required output format from the drop-down list.

Basic File
Format

Details

7th-YCoCg 3:1 Compression

7th files are a fixed file size for a specific resolution. This format is equivalent in quality to the best HapQ standard.

7th-420 2:1 Compression

7th-420 formats are equivalent to MPEG2 video standard, and compress the chrominance portions of the signal in both
axes These files have the best compromise between image quality and hardware requirements.

7th-422 1.5:1 Compression

7th-422 formats are equivalent to broadcast video standard, and compress the chrominance portions of the signal. These
files have the best compromise between image quality and hardware requirements.

7th-444 1:1 (No compression)

This is perfect image quality, though largest file size.

7th-6to1 6:1 Compression – an old file type that is rarely used now.

7th files are a fixed file size for a specific resolution, and are the best solution for normal movie playback due to the file
size reduction. These files are typically the smallest and require the least performance in the PC to play back.
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Distributed File Manager

Output File Name

The output file name is chosen based on the first file found in the folder
(03_caminandes_llamigos_1080p_ in the example above). You can edit this in the Basic tab to change
the base name of the output files if you prefer. We recommend you leave a trailing underline for
clarity.
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Distributed File Manager

Advanced Tab

Image Sequence Numbering Starts at
Normally, the output 7TH files are numbered 0000.7TH, 0010.7TH, 0020.7TH etc.
Files are output sequentially in ‘Optimize for SSD’ mode.

Start processing at frame
If you enter a frame number in here, DFM will ignore any frames previous to that number and
start conversion from that frame.

Stop Processing after frame
You can stop converting after the number of frames in this box to only convert a section of
movie. 

Use Partial Input
If you only want to output a section of the movie, select this option and type in the rectangle
which you want to convert. With this option off, the whole input movie is output.

Input Area
If you check the User Partial Input checkbox you are able to edit the input area (X, Y, width and
height of the images)

Resize Output
If checked, you can type in any size you wish into the Output Size boxes but the output width
will always round up to the nearest multiple of 4: for example, if you type in a width of 2057, this
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will automatically reset to 2060. This minor scaling feature improves playback performance in
Delta.

Output Size
The default nominal output width and height is shown here unless you check the Resize Output
checkbox to amend (as above).
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Encryption Option

Delta Content Protection System (CPS) is a content encryption and decryption system whereby
content imported onto a Delta Media Server can only be played back if certain criteria are met.

Delta CPS has the ability to allow the content creator to encrypt 7TH movie format files, selecting a
playback date-range and/or venue codes, so that their content will only play back within the dates
specified or the venue they choose.

Notes:

· Content protection playback requires use of an additional licence.

· To encrypt media requires a registry key setting.

Using Regedit, edit the value of HKEY_LOCAL_MACHINE > SOFTWARE > 7thSense > DFM >
EncryptionEnabled key, to y E s:
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This enables, a third tab under Output:

In DFM, check ‘Use Content Protection’ to enable the settings.

DAT file location
This contains the playback security information and must accompany the media in order to
decode it on the playback server.

CPR file location
The content creator can modify the movie protection details remotely, using the 7thSense
Content Protection Manager application, to produce a revised DAT file that can be sent,
extending dates or venues.

Password
Add a password and ensure that you note it securely.

Venue Code / any venue
To restrict play, uncheck ‘Play at any venue’ and enter a venue code or codes. In this example,
the movie will play at a venue coded Theatre, and also at any venue with code beginning
LiveEvents (e.g. LiveEvents1 and LiveEvents2 etc. – * is a character wildcard).

Date control
Uncheck ‘Unlimited’ to apply start and/or end dates.

For full details, see: Delta Content Protection System.
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Input File Warnings

Examples of warnings that you may get include:

Missing file(s) after frame N
If there are gaps in the numbering (e.g. file_100.jpg ,file_101.jpg, file_104.jpg) indicating missing
files, you cannot convert them, as this would lead to a black frame at that point. Files must be
sequential and present.

Note: you may get this error if viewing a Mac formatted drive which has a number of small files with
the same name (prefixed with a dot) as the actual images.

Filenames have different digit size
If files are named File1_0001.jpg to File_0100.jpg but the 50th file had an extra digit (e.g.
File_00050.jpg) it would cause problems: all filenames must have the same number of fixed
digits.
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Audio

If a Windows movie file containing audio is loaded and the codecs are present to render the audio
stream, the ‘Extract Audio’ area will be visible and available.

Audio is extracted into a set of WAV files (one for each channel) and placed into an ‘Audio’ sub-
directory of the specified output directory.

Suffixes applied for the channels (up to 8) are as follows:

_SUB subwoofer

_RSIDE right side

_RS right surround

_R right

_LSIDE left side

_LS left surround

_L left

_C centre
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External Control

DFM can be controlled remotely via Ethernet, normally using a telnet interface on port 33, although
this is configurable within DFM: Settings > External Control.

To configure DFM, select Settings > External Control and type in the port over which you wish to
communicate with DFM.

The full range of file conversion steps detailed in the File Convert section above is available through
external control via these commands:

LOAD "fullpath" Load the DFM files in this path

INPUTFILE "fullpath" Set the input file for a single file movie

INPUTFOLDER "fullpath" Set the path to find image sequence files

INPUTFILETYPE type jpg, tif, tga, dds, bmp, png

OUTPUTFOLDER "fullpath" Set the output path for converted files

OUTPUTFILETYPE type 7th (currently)

OUTPUTFILENAME Override the automatic output filename

INPUTIMAGESIZE X Y W H / NATIVE Specify which part of the image to use, or use the whole
image (default) by choosing Native

OUTPUTIMAGESIZE W H Override the automatic output image size

OUTPUTSTARTSAT frame The output file numbering starts with this number (has to
be divisible by 10)

STOPAFTERFRAME frame Stop converting after this frame number

CONVERT Start the conversion process

CANCEL Cancel the conversion process

STATUS Return DFM status

SHORTSTATUS Return short DFM status : canconvert frame framecount
mode width height skipexisting

WARNINGS Return any warnings

TIMEDSTATUS Y / N When Y, output the current frame and the total frame
count after every 10 frames.

QUIT Quit the application
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QUITAFTERCONVERT Quit the application once the current conversion has
ended.

MINIMIZE Minimize dialog and playback window

RESTORE Restore dialog and playback window

HELP This help information

The various commands are not case sensitive, and are actioned by Carriage Return (character 13).
The strings OK or BAD are returned after each command indicating syntax success or failure.

A typical sequence would be:

INPUTFOLDER "c:\mymoviefolder\beach movie"
OUTPUTFOLDER "c:\mymoviefolder\beach movie\output"
INPUTFILETYPE jpg

You can now see if there were files found using STATUS – this returns full status information such as:

INPUT: c:\mymoviefolder\beach movie\*.JPG

OUTPUT: c:\mymoviefolder\beach movie\output\*.7th

FRAME: 0

FILECOUNT: 198

INPUTSIZE: 0 0 512 768

OUTPUTSIZE: 1024 x 768

DEINTERLACE: Off

MODE: Stopped

CANCONVERT: Yes

SKIPEXISTING: No

QUITAFTERCONVERT: No

Note the CANCONVERT flag: if this is No, then it could be no files were found (FILECOUNT will be 0) or
there are problems with the files found. Check this by sending WARNINGS you get back (for
example):

Files 'Stargaze_00014.jpg' and 'Stargaze_0002.jpg' have different digit size!

or

Missing file(s) after frame 14 !
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Correct these problems, and then send REFRESH to update the status information.

You can set the OUTPUTFILENAME which overrides the one chosen by DFM, but be aware that any
of the other commands causes this to be reset to the automatic one, so issue this command last
before sending CONVERT.

While conversion is progressing, you can check it by requesting STATUS to see the current frame
increasing, or request SHORTSTATUS, which returns a string such as this: 1 0 198 0 1024 768 0

These numbers represent these facts:

Digit Description

1 Canconvert 0 = No, 1 = Yes

2 Frame Current frame number

3 Framecount Number of files found

4 Mode 0 = Stopped, 1 = Converting

5 Width Output image width

6 Height Output image height

You can send CANCEL at any time to stop conversion.
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Command-Line Interface

In a similar fashion to telnet, DFM can be operated via a command line. To run DFM from the
command line, specify the file name (i.e. DFM.exe), followed by some combination of the following
flags and parameters:

/if "fullpath" Set the path to find image sequence files – this should be the full
path to one of the image sequence files*

/in "fullpath" Full path of windows movie file (mpg, wmv, etc.)*

/of "fullpath" Set the output path for converted files*

/oft type 7th (currently)

/on "filename" Override the automatic output filename

/inputimage X Y W H Specify which part of the image to use.

/ossd Optimise for SSD

/outsize W H Override the automatic output image size

/outstart frame The output file numbering starts with this number (must be divisible
by 10)

/stopafter frame Stop converting after this frame number

* Denotes a required parameter

For example:

DFM /if C:\Frames\Source /ext jpg /of C:\Movies\Test /on crosshatch /oft 7th-
444 /outstart 100 /stopafter 1000 /inputimage 0 0 10 10 /outsize 768 768

This command line specifies the following:

All JPG files (matching the name of the first JPG found) from C:\Frames\Source will be converted into
7TH-444 format and placed into C:\Movies\Test\crosshatch_xxxxx.7th files (where xxxxx is the
output number).

Only the top left 10 pixel square will be used from each input frame and the frame written to the
output will be blown up to 768 ´ 768.

Output files will start at crosshatch_00100.7th, followed by crosshatch_00110.7th,
crosshatch_00120.7th, etc., until either all frames have been written, or the first 1000.
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SMTP Email

DFM can be set to send email notifications on completion of file conversions: Settings > SMTP
Configuration.
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Codecs

DFM2 uses Direct Show Filters for all its conversions. The following formats are supported natively.

File formats:

MXF

MOV

MP4

LXF

ASF

WMV

DV

MPEG-PS

MPEG-TS

GXF

FLV

AVI

MKV

WebM

This includes unencrypted DCP packages with MXFs and JPEG 2000 streams.

Audio Codecs: Video Codecs: Image Sequence Formats

AAC

MP2

MP3

WMA

Vorbis

FLAC

DVCPRO

M-JPEG

MPEG-1

MPEG-2

MPEG-4

H.264

AVC

VC-1

VP8

VP9

HuffYUV

DNxHD

ProRes

H.265

DPX (10,12,16 bit per pixel)

TGA (24 bit and 32 bit per pixel)

PNG

BMP

GIF

JPG

TIFF (8, 16 bit per pixel)

If the format of your media is not one of the above, then please make sure the correct direct show
codecs are installed, and that they are capable of decoding the media you wish to convert.

Windows comes with a variety of codecs as standard for converting files such as WMV, AVI.

DFM Installs the codec pack ‘FFDShow’. This extends DFMs capabilities to allow conversion of XviD,
MPEG-1, MPEG-2, MPEG-4, H.263, MJPEG.
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Delta Content Protection System

Delta Content Protection System (CPS) is a content encryption and decryption system whereby
content imported onto a Delta Media Server can only be played back if certain criteria are met.

Traditionally, Delta plays back its own native movie format (STH/7TH files) which are optimized for
streaming uncompressed movies from standard hard disks or newer solid state drives. 

Delta CPS has the ability to allow the Content Creator to encrypt the STH/7TH movie files selecting a
playback date-range and/or venue codes, so that their content will only play back within the dates
specified or the venue they choose.

This manual should be read in conjunction with the Delta User Guide, which explains the basic
concepts of adding and working with content on the timeline, also the DFM User Guide, this
explains the content conversion process.
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Delta Content Protection System Architecture

What You Need

Encrypted Content Creation

The tools needed for the content creation are the 7thSense DFM Utility with a Delta CPS Encryption
licence (USB key), plus a manual Registry key setting.

Encrypted Content Playback

To playback the encrypted content, the 7thSense Delta Media Server Software with associated Delta
licence is required.

Managing Content Licences Remotely

To change any previously produced encryption criteria, the 7thSense Content Protection Manager,
Delta CPS Encryption licence and the original CPR file are required.
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Workflow
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The Content Encryption Process

Delta licences are purchased with a specific Venue Code burned in, for example ‘7thSense’.

Using the 7thSense DFM Utility, the Content Creator can encrypt the source movie content and the
supporting information is held within a DAT file.
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Encrypted Content on the Delta Media Server

The creator can now send the movie (7th files) and a copy of the DAT file on a USB hard drive to their
customer, secure in the knowledge that the movie will only play back between the chosen dates and
if the Venue Code matches the Delta licences on site.

If any of the security criteria are not met, the movie is scrambled onscreen and cannot be decoded.

Security criteria that will prevent the movie from being viewed include:

· DAT file missing

· DAT file Venue Code does not match the Delta USB key Venue Code

· PC Date not within DAT file’s Start to End Date

· Time source has been tampered with

· Delta not licensed for encryption playback
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Remotely Updating an Encrypted Configuration

If the Content Creator wants to remotely extend a show’s dates or change it to play at any or other
venues, they can use the 7thSense Content Protection Manager. This is accomplished by the Creator
editing the originally created CPR files held locally.

Using this program, the Creator can change the venue code, start or end date. Wildcards can also be
used for the Venue Code, so for example setting it to LiveEvents* would allow this show to play on a
Delta server licensed with LiveEvents1, LiveEvents2 and so on.

The output of this Manager is a modified DAT file that can be easily emailed to the site, and placed on
the Delta PCs, changing the playback criteria immediately.
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Creating Encrypted Content using DFM

The items needed for the encryption process are:

· the Source Movie

· the 7thSense DFM Software Utility and 

· a Delta CPS licence.

Note that DeltaGUI will not recognise the CPS licence if it is on a second dongle: ensure that it is on
your main server licensing dongle.

Prepare Configuration

On the PC used for encrypting the movie content:

· Install DFM

· Insert the USB Delta CPS Licence Key

· Confirm the movie content to encrypt is accessible from this PC

· Start DFM

Drag and drop a single movie file into DFM, selecting an appropriate location for the converted files to
be output. (Note: DFM will pick up the rest of the movie for conversion.)
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More information on DFM file conversion is in the DFM User Guide.

To encrypt the converted files, click on the Encryption tab. By default, content protection is not active
in DFM; check the Use Content Protection checkbox. A new Content UID will be generated
automatically.
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· Create a location to store the DAT and CPR files in by using the browse button or typing the
location in the relevant box.

· Create a password and retype to confirm.

Venue and Date Configuration

Venue Configuration

· To set to playback at a specific Venue location, add the Venue name in the Venue Code box. The
venue name is the ID within the venue specific Delta USB key at the Delta playback location. For
example, the Venue ID might be LiveEvents1.

Multiple venue codes can be entered, separated with a Comma, Space or Semi-Colon so for
example, to play the media on all Delta Media Servers at the venue named LiveEvents, type in
LiveEvents*. The asterisk is a wild card so will pick up all servers named LiveEvents[n].

· Make sure the Play at any venue checkbox is unchecked. If checked, media will not be limited to
your selection and will be allowed to play at all venues.
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Date Range Configuration

· To have the movie to play within certain dates, uncheck the checkbox next to either the Start date
(inc) or the Stop date (inc) or both. Type the start/stop dates in the appropriate boxes.

Notes:

· Venue codes are not case sensitive and MUST match the venue code that is recorded on your
licence

· Dates are inclusive, so for a licence with a stop date of 31/05/2018, the content will play up to
midnight on the 31 May 2018.

Run the Encryption

Once you have added your media and configured your preferences for Encryption, press Convert and
the movie will start converting into the 7TH format. The progress bars at the bottom of the screen
demonstrate the conversion progress. You can Pause or Stop the process at any time.

Once completed, the encrypted movie content is stored as a CPR and a DAT file.

The movie content files (7TH movie files that were created within DFM from the original) and the DAT
file can then be sent to the End User for installing and ingesting on the Delta Media Server.

The CPR file and known password should be kept with the creator for future amendments.
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Installing the Encrypted Content onto Delta
· Add the Encrypted Content as you would for non-encrypted content (information on how to do

this is in the Delta User Guide).

· Add the DAT file in a known location on the Delta Media Server.

· Confirm the Delta Venue licence is plugged in to a USB port on the Server. 

Note: if you have a separate Delta Licence already plugged in (often internally), your second dongle
will not be recognized and the GUI will not have the appropriate Encrypted Movies menu. Remove
your first dongle if necessary!

· Run the DeltaServer and DeltaGUI software.

Ingest the Media

To ingest the DAT file, click on the Encrypted Movies tab at the upper left of DeltaGUI, then click
Ingest Encryption Files.

· Browse to the location where the DAT files are stored

· Select the DAT file to Ingest.

· Click Open button to ingest the DAT file.
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DAT File Ingested will show briefly on the DeltaGUI message bar when ingested:

To confirm the content and movie will work at this venue, click on the Encrypted Movies tab, then List
Encrypted Movies.

The list shows the encrypted movies Delta can locate. It will also show the status of each movie,
when and whether it is able to play at this venue.

Note: the encrypted movie won’t play if the venue doesn’t match the licence or the current date is not
within the encryption date limits. If either case is preventing the resource to run, when dropped onto
the timeline the movie will look like this:

However, if the encryption properties are within range and Delta is able to play the movie at this
venue, when dragged onto the timeline, the movie will be pink and play in the same way as non-
encrypted movies. If you hover over the resource, you are able to see further details of the Encryption
status and dates range (if appropriate).
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Important:
Encryption playback requires this Registry key setting, which may require editing: 
\HKEY_LOCAL_MACHINE\SOFTWARE\7thSense\Delta\Graphics\MediaGrabsUseGLMemDirectly
= 0
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Manage Shows Remotely

If the Content Creator wants to remotely make changes to the encryption properties (such as change
dates or venue details) they need the 7thSense Content Protection Manager application.

The items needed for the remote management process are the originally created CPR file, the
Content Protection Manager Software Utility, the Delta CPS licence and the Creator password.

On the PC that is to be used for encrypting the movie content:

· Install Content Protection Manager

· Insert the USB Delta CPS Licence Key

· Load/confirm the original CPR is present.

Start the Content Protection Manager

Click Next to continue



60

MC256-9 Managing Media for Delta : User Guide 
 
                                                                                                       © 2024 7thSense

Delta Content Protection System

· Browse and select the source folder of the CPR file in C:\EncryptionFiles\CPR

· Check the Include sub-folders checkbox if the file is in a sub folder of the current folder.

· Type the password that was used to create the original CPR, in the creator password box.

· Once the next button is pressed, the Manager will search for CPR files that are related to the
password entered.

· If any CPRs are found relating to the password, the Manager will open a new window showing all
relevant CPRs.

Select the CPR to manage:
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The relevant details will be displayed for your selected movie.

Note that if you have set the movie to play at any venue with unlimited dates (all checked) no Venue
Code will be visible and the dates will default to 01/01/2000 and be greyed out.



62

MC256-9 Managing Media for Delta : User Guide 
 
                                                                                                       © 2024 7thSense

Delta Content Protection System

Note: You can select multiple CPRs and add the same protection information to multiple CPR’s
simultaneously.

The encryption information may now be edited if required:

· To set to playback at a different Venue location, change the Venue name in the Venue Code(s)
box.

· To play at any venue, check the Play at any venue checkbox.

· To have the movie play within certain dates, uncheck the checkbox (if checked), next to either the
Start date (inc) or the Stop date (inc) or both. Type the start/stop dates in the appropriate boxes.

· To set unlimited start and stop dates, check the Unlimited checkboxes next to the relevant dates.

· Pressing the change Creator password button allows you to change the currently saved password
for the selected CPR. Type in the old password and then the new one.

· To create and new DAT file for the encrypted content, check the Create DAT file checkbox.

If you make changes to the encryption details, the Next button will become active:
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Click Next to show a window asking for you to select new output folders for modified CPR and DAT
files. This is to enable you to maintain previous as well as create new – else the system will overwrite
your previous files.

Click Next once you have selected where you want your DPR and DAT files to be stored.
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Click the Finish button to close the Management program.

The newly-created DAT file can now be sent to the Venue for installing on the relevant Delta Media
Server. The CPR file should be kept with the Content creator for any further possible changes.
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FAQs

Does it also encrypt the audio?

No, only the video is encrypted.

Can the content and DAT file also be used on another Server?

Yes, providing the correct licensing criteria are met.

Do I need to keep the DAT file once it’s been ingested?

Yes, this needs to reside in the DAT folder.

What happens if I try and play a movie that is not allowed at my venue?

The output from Delta will be scrambled and the resource in timeline will show in purple with yellow
text stating why the resource won’t play:

I have lost the DAT file before ingesting it. Can I get another one?

The Content Creator can create a duplicate DAT file from the original CPR file

I have forgotten my management password, what can I do?

The content will need to be re-encrypted.
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Batch Export to TGA in Adobe After Effects

If supplied with movie media that has a transparency (alpha channel), you can use DFM to convert
that media to .7th 444A for RGB+A support, or strip out independently the RGB or alpha channels. The
benefit of the latter, for example, is if you have transparent media that is intended to be a luma key
only and do not need the full RGB information, but only the alpha channel. This can result in a
significant savings of storage and bandwidth requirement for playback.

DFM natively supports 32-bit TGA (RGB+alpha) content for this process (and Delta supports native
playback of 32-bit TGA). Other transparent media, however, will need to be converted to 32-bit TGA
before ingesting into DFM to convert to .7th 444A. The following steps are an example of how to
convert from a PNG image sequence with transparency, to 32-bit TGA using Adobe After Effects CC.

Steps to Export as 32-bit TGA

1. Import your media with transparency into a new After Effects project

2. Right-click the image sequence and select ‘New Comp from Selection’

3. Verify the settings are correct – note that source framerate at this point is irrelevant as we are
doing a frame for frame conversion.

4. With the new composition opened in After Effects, select the Composition > Add to Render Queue

5. In the Render Queue output settings, do the following:

a. Set ‘Render Settings’ to Best Settings

b. Click on the current option next to Output Module to open the ‘Output Module Settings’
window.

c. Set Format to Targa Sequence, select RGB + Alpha from the Channels menu, and then verify
that 32 bits/pixel is selected under the ‘Format Options…’ button.

d. Click OK in both windows

e. Set your preferred file name

6. Press ‘Render’

Once the render is complete, you will have a 32-bit RGBA TGA image sequence. Delta can play this
back natively and, depending on the composition of the show, you may not need to use DFM.
However, if you would like to convert to .7th to render only the alpha channel, you can do so by
following these steps in DFM.

Convert TGA to 7TH Using DFM

Open DFM and load the media into the queue by selecting the ‘add media’ button in the top menu bar.

Find your newly created TGA sequence and select the first file, then Open.
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Once loaded into the queue, you will note that DFM defaults to 444 where you would normally have
the option of 444, 422, and 420, and adds a pull-down menu that defaults to RGB & Alpha.

· Using the pulldown menu, select RGB & Alpha, Just Alpha or Just RGB as required

· Ensure the other settings are correct (such as ‘Optimize for SSD’) and then press Convert at the
bottom of the screen.

DFM will convert your media as required.
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7th and sth Plugins for Adobe CC and Nuke

7thSense Design has plugins for the popular design and compositing suites, Adobe® After Effects
and Media Encoder, and Nuke® from The Foundry, that convert movie media into the optimised .7th
file format, which then also allows for encryption using the 7thSense Content Protection System
application.

This new 2021 plugin for Adobe Media Encoder .uses the Adobe MediaCore API that can
be used in After Effects or Premiere Pro, or directly in Adobe Media Encoder. Available for
Windows and macOS, it includes reading and writing between .7th files and any other
format, so can be used very flexibly.

Plugin v.2.2.1 for Nuke  Reader and Writer, with revised interface and increased
read/write format range.

The original plugin for After Effects  did not offer reading, only writing.
After Effects can also batch export to 32-bit TGA, which can be converted to .7th format
using the 7thSense DFM application.

Original v.1 Plugin for Nuke . .7th format 4:2:2 files are saved as the equivalent .sth
extension.

Download links are provided in these pages. For further help on media plugins, please contact
support@7thSense.one.
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AdobeMediaCore7th Plugin

Introduced in 2021, this Adobe MediaCore plugin offers maximum flexibility. It reads .7th files and
writes any format out to .7th formats, and is accessible in Media Encoder directly, and for use with
After Effects and Premiere Pro. For example, in After Effects, Choose File > Export > Add to Media
Encoder Queue and Media Encoder will open. Your After Effects composition will appear in the Media
Encoder queue, and Media Encoder can then do the rendering, freeing up After Effects to continue
working.

Downloads

Right-click to download (save link as) zip files of Adobe MediaCore7th:

Ø Adobe MediaCore7th (Windows) 

Ø Adobe MediaCore7th (MacOS)

Formats supported

Format Import Export

8-bit YCoCg DXT5     

8-bit YCbCr 4:2:0     

8-bit YCbCr 4:2:2     

10-bit YCbCr 4:2:2     

12-bit RGB 4:4:4     

8-bit RGB 4:4:4    

8-bit RGBA 4:4:4    

8-bit BGRA 4:4:4    

Compatibility

Creative Cloud CC2019-, 64-bit for Windows and macOS. (Note that Apple Silicon is not supported.) 
For example After Effects connects directly with Media Encoder:

https://portal.7thsense.one/user-guides/resources/AdobeMediaCore7th-Win.zip
https://portal.7thsense.one/user-guides/resources/AdobeMediaCore7th-MacOS.zip
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Installation: Windows

There are two files:

· Exporter7th.prm

· Importer7th.prm

Place these in C:\Program Files\Adobe\Common\Plug-ins\7.0\MediaCore. Admin privileges are
required to write to this folder.

If these subfolders do not exist, just create them.

To test if the importer plugin has loaded correctly, run Adobe Media Encoder and browse to a folder
with .7th or .sth files (RGB or YCbCr 4:2:2) and thumbnails should appear in the Media Browser
window. To test if the exporter plugin has loaded correctly, run Adobe Media Encoder and create a
new export job – the new exporter should be present under the title ‘7thSense’. If installing over an
existing plugin, preferences may not display correctly. Delete the Adobe Media Encoder preferences
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file (typically under Users\[USERNAME]\Documents\Adobe\Adobe Media Encoder\[VERSION]
\Presets\PresetTree.xml) and restart Media Encoder.

Installation: macOS

There are two installers:

· Exporter7th.bundle

· importer7th.bundle

Copy these to /Library/Application Support/Adobe/Common/Plug-ins/7.0/MediaCore. Admin
privileges are required to write to this folder.

If these subfolders do not exist, just create them.

On your Mac, use Extensions settings to enable and disable Apple and third-party extensions for your
Mac and select extensions to include in the Share menu. Extensions, such as Markup, add extra
functionality to apps, the Finder and the Touch Bar.

To change these settings, select Apple menu > System Settings, click Privacy & Security in the sidebar,
then click Extensions on the right.

To test if the importer plugin has loaded correctly, run Adobe Media Encoder and browse to a folder
with .7th or .sth files (RGB or YCbCr 4:2:2) and thumbnails should appear in the Media Browser
window. To test if the exporter plugin has loaded correctly, run Adobe Media Encoder and create a
new export job – the new exporter should be present under the title ‘7thSense’. If installing over an
existing plugin, preferences may not display correctly. Hold down the Shift key while loading Adobe
Media Encoder or Premiere Pro to delete the plugin cache.

Application

Importer, from Media Encoder

1. Select File > Add Source from the menu.

2. Select the first and last files in the .7th movie sequence you wish to import.

3. Ensure ‘7thSense Importer Format Sequence’ is checked.

4. Click ‘Open’ and the still frame sequence should be imported as a movie clip to the encoder
queue.

Exporter, from Media Encoder

1. Import the movie clips to the encoder queue.

2. Click on the ‘Format’ cell to bring up the ‘Export Settings’ dialog.
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3. Click the ‘Format’ drop-down menu and select ‘7thSense’.

4. Select the desired output codec using the ‘Codec’ drop-down menu in the ‘Video codec settings’
group.
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Exporter, from Adobe After Effects

The MediaCore exporter is supported in After Effects via Adobe Media Encoder. Select ‘Add to Adobe
Media Encoder Queue’ to import the composition to Adobe Media Encoder, and then follow the steps
for Adobe Media Encoder from step 2 onward.

Troubleshooting

Premier Pro: double-check the correct installation folder is being used:

https://ppro-plugins.docsforadobe.dev/intro/plugin-installation.html 

Check the plugin loading log as described here:

https://ppro-plugins.docsforadobe.dev/intro/load-em-up.html#resolving-plug-in-loading-problems 

Adobe Media Encoder log files:

https://helpx.adobe.com/uk/media-encoder/using/log-files.html 

https://ppro-plugins.docsforadobe.dev/intro/plugin-installation.html
https://ppro-plugins.docsforadobe.dev/intro/load-em-up.html#resolving-plug-in-loading-problems
https://helpx.adobe.com/uk/media-encoder/using/log-files.html


79

MC256-9 Managing Media for Delta : User Guide 
 
                                                                                                       © 2024 7thSense

7th and sth Plugins for Adobe CC and Nuke

Nuke7th Plugin v.2.2.1

This 2023 rework of the Nuke reader/writer plugin expands the range of formats available, with a
revised user interface.

Downloads

Right-click to download (save link as) zip files of the Nuke7th plugin:

Ø Nuke7th Plugin v.2.2.1 for Nuke 12.2v5 (Windows) 

Ø Nuke7th Plugin v.2.2.1 for Nuke 13.0v2 (Windows)

Ø Nuke7th Plugin v.2.2.1 for Nuke 14.0v2 (Windows)

Ø Nuke7th Plugin v.2.2.1 for Nuke 12.2v5 (Linux CentOS7)

Ø Nuke7th Plugin v.2.2.1 for Nuke 13.0v2 (Linux CentOS7)

Ø Nuke7th Plugin v.2.2.1 for Nuke 14.0v2 (Linux CentOS7)

Formats supported

Format Import Export

8-bit YCoCg DXT5     

8-bit YCbCr 4:2:0     

8-bit YCbCr 4:2:2     

10-bit YCbCr 4:2:2     

12-bit RGB 4:4:4     

10-bit RGB 4:4:4     

8-bit RGB 4:4:4     

8-bit RGBA 4:4:4:4     

8-bit BGRA 4:4:4:4    

Compatibility

Nuke 12.1v5, 12.2v2, 12.2v5, 13.0v2, 14.0v2 on Windows and Linux CentOS 7.

https://portal.7thsense.one/user-guides/resources/Nuke7th-Win-12_2v5.zip
https://portal.7thsense.one/user-guides/resources/Nuke7th-Win-13_0v2.zip
https://portal.7thsense.one/user-guides/resources/Nuke7th-Win-14_0v2.zip
https://portal.7thsense.one/user-guides/resources/Nuke7th-Linux-12_2v5.zip
https://portal.7thsense.one/user-guides/resources/Nuke7th-Linux-13_0v2.zip
https://portal.7thsense.one/user-guides/resources/Nuke7th-Linux-14_0v2.zip
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Installation

There are 2 .dll (CentOS: .so files): sthReader and sthWriter, for this plugin.

The zip package for each platform contains all the files needed to load the plugins in Nuke.

https://learn.foundry.com/nuke/developers/63/ndkdevguide/intro/pluginbuildinginstallation.html

Windows

Extract and copy the contents of the downloaded zip package to Nuke user home folder, e.g. C:
\Users\[USERNAME]\.nuke.

https://learn.foundry.com/nuke/developers/63/ndkdevguide/intro/pluginbuildinginstallation.html
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Linux

Extract and copy the contents of the downloaded zip package to Nuke user home folder, e.g. /home/
[USERNAME]/.nuke.

Nuke7th Reader/Writer

From Nuke, select from the STH Options:

Nuke does not handle files with numeric characters well, so this exports to file extension .sth.
Extensions .sth and .7th are equivalent in DeltaServer.
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7th AfterEffects v.1 Plugin

Formats supported

This original plugin (issued 2016-2019) supports export of the 7th 4:2:2 8-bit and 7th 4:2:2 10-bit
image sequence format only. For importing and exporting and to more formats, see the Media
Encoder plugin , introduced by 7thSense in 2021.

Compatibility

Creative Cloud CC2019, 64-bit for Windows/macOS.

Downloads

Right-click to download the plugin (save link as):

Ø Adobe AfterEffects plugin (Windows) 

Installation: Windows

For a standard Windows installation using the latest Creative Cloud release, the 7thAE.aex file should
be copied to the following After Effect plugin location:

C:\Program Files\Adobe\Common\Plug-ins\7.0\MediaCore

If this does not exist, the plugin copy it to the equivalent directory for your version of After Effects.

Installation: macOS

Before CC 2019:

For a Mac installation using the latest Creative Cloud release, the 7thAE.plugin package should be
copied to the following After Effects plugin location:

/Library/Application Support/Adobe/Common/Plug-ins/[CS version]/MediaCore/

CC2019, verified with Catalina 10.15.1:

Add 7thSense plugin to path:

/Applications/Adobe After Effects CC 2019/Plug-ins/Extensions Start After Effects. It will fail, but click
Cancel instead of moving it to the Bin. Shutdown After Effects.

73

https://portal.7thsense.one/user-guides/resources/7thAE.aex
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Go to the ‘Security & Privacy’ panel, ‘General’ tab. This will show that the plugin was recently
prevented from running. Click ‘Allow Anyway’.

Run After Effects again. This time an extra option of ‘Open’ is shown, select this. After clicking open
after effects will run and the plugin is seen.

Next time you start After Effects, you shouldn’t see the prompt but the plugin should be available for
use.

Application

For 7th 4:2:2 10-bit render output, it is important that the After Effects project ‘Project Settings’ are
configured to output a depth higher than the default 8-bit. There is no 10 or 12bit project depth option,
only 8, 16 & 32bit (float):

For 10-bit renders you need at least a 16 bits per channel.

To configure the render output for 7th 4:2:2 10-bit:
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Note: you can only do 24-bit RGB renders, not RGB+A (32-bit).

The depth of ‘millions of colours’ would produce 8-bit files, ‘trillions of colours’ gives 10-bit.
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Nuke7th Plugin v.1

Nuke does not recognise numeric characters in filenames. .7th format files need therefore to be
saved to .sth file extensions.

Formats supported

This plugin supports export of 4:2:2 10-bit and YCoCg, and the 7th 4:2:2 or sth 4:2:2 8-bit image
sequence format.

Compatibility

Nuke 9, 10 and 11 for Windows, macOS, Linux.

Installation

Once built, your plug-in binary (a shared library with the appropriate .dylib/.so/.dll extension
depending on your platform) will need to be placed in a path where NUKE scans for plug-ins on
startup. On all platforms this will be either your ~/.nuke (i.e. <user home directory>/.nuke/, where the
dot prefix may mean it is hidden by default in your file browser), or somewhere in your NUKE_PATH
which defaults to:

· macOS 64-bit: /Library/Application Support/NUKE/x.x/plugins/

· Linux 64-bit: /usr/local/NUKE/x.x/plugins/

· Windows 64-bit: C:\Program Files\Common Files\NUKEx.xplugins

Where <x.x> is the major.minor version of the NUKE in question. Conveniently, NUKE_PATH can be
added to by setting an environment variable of the same name. This is often of use when building
and testing plug-ins, because you can set an environment variable pointing at your build directory and
then fire up NUKE to try it out.

It is recommended when packaging up NDK plug-ins for distribution that you use the NUKE_PATH
directories, and install your bundle in an appropriately named subdirectory (since the default path is
searched single level recursively).

There are several ways to add a plug-in to your current session.

· Hit x to bring up the script command and type in the name of the plug-in and hit enter. If the plug-
in is found in the various paths searched for the plug-in, an instance is added to the Node Graph.
This is generally of most use when first setting up plug-ins. If this fails, you may want to try the
script command ‘load <my plug-in name>’ which tests that the plug-in can be found and that
dynamic loading works. The common reasons why this might not work is that the
DD::Image:::Op::Description is incorrect, or that the plug-in has been built against a different
version of the NDK than that supported by the version of NUKE you’re trying to load it into.
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· Go to the Other > All plug-ins menu and hit update, or hit tab and type update-enter. Both of these
add the full list of found plug-ins to the menu (and thus tab selector), allowing them to be added
by the usual means. Again, this is generally of most use when first setting up plug-ins.

· You can add your own menu entry to the default toolbar by adding a menu.py file to the
NUKE_PATH and following the guidelines laid out in the Python Reference Guide. This is
recommended for packaging up plug-ins for distribution as it allows easy discovery of your tools.
Additionally, any pre-requisite Python elements can be initialised in menu or init.py, including the
usual icons and so on.

sth422Reader / Writer

This is a Nuke File Reader plugin to read 10-bit and 8-bit 4:2:2 .sth and .7th files. A .sth/.7th file
represents a frame of media to be used for playback with Delta Media Servers.

There is a 7thReader.tcl file: please place this in the .nuke directory along with the plugins. This file
allows the sthReader to be loaded when a .7th file is read.

sth Output Options from Nuke

The plugin allows selection of file extension, bit-depth and compression:
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Output .sth as .7th
check this to rename the extension from .sth to .7th.

If neither of the two following options are ticked, output is 4:2:2 8-bit. Otherwise:

Output YCoCg
select to output with this compression type (8-bit only)

or

Output 10bit Per Pixel
select to output 4:2:2 10-bit

A Point to Consider

· When using the sth422Writer and sth422Reader to write your Nuke render to a .7th or .sth format,
and then subsequently read it back into Nuke, you will see a change in the RGB values compared
to your original in Nuke. This is to be expected.
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· The reason is that each Red, Green and Blue pixel value in Nuke is represented as a 32-bit float,
and when the data is saved to file, these values are converted to 8 or 10-bit. This is necessary to
make them compatible with 8 or 10-bit .sth or .7th files. This process causes the original data to
be approximated so the information can be encoded within the specified number of bits. When
the data is then read back using the sth422Reader, it begins its conversion process at the saved
approximated value. Therefore, after the reader has done its processing and fed that information
back to Nuke, it will give slightly different RGB values to those originally created in Nuke.

· For this reason, it is recommended that content creation and changes are done on the original
Nuke node and not on a node that has been read from the sth422Reader. The reader should be
used primarily for checking frames, not editing.



Video Capture Options
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Video Capture Options

Video capture features allow Delta Media Servers to composite live feeds into the Delta Server
output. This could be from another physical  device such as a video camera, or over the network as a
video share using Spout, or in the form of a live web page, or a broadcast stream. The following are
some example use-cases.

Ø Search keyword ‘capture’ in the Delta User Guide. 

Hardware capture

The project requires a multiple server solution in a theme park for a stage show, and as visitors walk
into the arena, their reactions are to be captured and composited within the main display. The Delta
Media Server driving the display will have a capture card capable of taking two HDMI inputs from two
separate video cameras. On screen there will be two overlaid images showing what the cameras can
see.

Delta Media Server supports capture cards from the following manufacturers, that will accept inputs
from various live or playback devices and sources:

· Datapath*

· Matrox

· Magewell

· Blackmagic

* Datapath DisplayPort Cards: Variable Resolution Capture

If the capture source connected to a Datapath DP capture card changes, Delta will interpret the
incoming feed at an incorrect frame rate (for example when set up for a 3840 × 2160@60 fps source,
a replacement source of 1920 × 1080@60 fps when forced to the same height and width, may be
interpreted down to 15 fps).

This can be resolved by monitoring the capture feed resolution by editing a Delta System Sequence
and enabling it with the System Sequences checkbox. Copy and paste this block:

Sequence name: OnSystem_CaptureSignalChanged

$startblock
if($signalpresent == 1)
{
  MEDIAPROPERTIES ctrlname=$system_resextctrlname forcew=$pixels forceh=$lines
}
$endblock

https://portal.7thsense.one/user-guides/M384-delta2_7-user-guide/
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Web capture

Stadium managers for a football game are using a Delta Media Server to drive a massive live
coverage display using camera feeds to a capture card. They want to overlay results from a web
page and the home team’s Twitter feed. The camera capture resource is in full-screen mode. By
adding ‘Web Capture Resources’ to the Delta timeline, with URL addresses for the additional feeds,
these can be re-sized/positioned to suit and switched in or out during the match.

Streaming service

A number of TV channels offer encrypted streaming services; a venue wants to be able to incorporate
one using Zixi Broadcaster and Reciever. By using a Stream capture resource on the Delta timeline,
the broadcast can be composited as a window in the playback display. All that is required is the Zixi
licence and the relevant URL.

http://portal.7thsense.one/user-guides/M509-zixi-broadcast-capture/index.html?zixi_install_and_configure_zixi.html
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NDI (Network Device Interface)

A project for a live video games conference requires four PC gamers to be seen playing against each
other, with each of their displays to be composited within a main background display from a Delta
Media Server. By placing all sources on the same network as the server, this becomes a suitable
application for Newtek NDI* tools to pull in a stream from each player desktop and composite them
live within the main display. Just set up the correct ports and add NDI capture resources to the Delta
timeline using the NDI stream names.

* The protocol created by Newtek that allows for capture over IP. Designed with broadcast quality in
mind, it has low frame latency and is well-suited to switching between inputs.



7thMovieViewer
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7thMovieViewer

7TH / STH, TGA and DPX* movie sequences can be played or viewed frame by frame in
7thMovieViewer. Since Delta 2.6 this is installed with DeltaServer as a Delta Utility. If you
have an older version of DeltaServer, contact support@7thsense.one for a copy of the

application.

To use the viewer regularly, create a desktop shortcut from C:\Program
Files\7thSense\Delta\Utilities\7thMovieViewer64.exe.

7thMovieViewer version 1.0.11

File > Open

Browse and open any frame in a folder sequence of .7th, .sth, .tga or .dpx* files, and as soon as you
play or move frame, the viewer will jump to the first frame in the folder sequence.

* DPX 10-bit 4:2:2 and 10, 12 and 16-bit 4:4:4 are supported

Note that older 6:1 compression 7th/sth images will not render in 7thMoveViewer. (See Delta Server
user guide: Movie formats.) If you have these, they can be recorded out to a different format from
DeltaServer (see Real-Time Recording). To find the format of any 7th files, place a movie on the Delta
timeline and hover over the file for the metadata:

mailto:support@7thsense.one
https://portal.7thsense.one/user-guides/M723-delta2_8-user-guide/index.html?media_movie_formats.html
https://portal.7thsense.one/user-guides/M723-delta2_8-user-guide/index.html?media_movie_formats.html
https://portal.7thsense.one/user-guides/M723-delta2_8-user-guide/index.html?deltagui_realtime_recording.html
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Movies can be played, viewed frame by frame, and also scaled / zoomed. Click the question icon or
the Help > About menu for a list of shortcut keys:

Play controls

Start and stop play of a movie sequence with the space bar. Use the left/right arrow keys to step
through frame by frame. Use the bottom scrollbar to move rapidly to any play position.

View > Goto frame (or the ‘g’ key) enables you to go to a specific frame number (in the current
sequence, starting 0).
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Features

Scale controls

Zooming in or out is based on the cursor position. Press 0 to refit to the window at any time.

Zoom in: from the View window, or using the number keys, choose 0 (zero) scale to fit the frame to
the viewing window, or scale up from full size (×1) to ×9. 

Zoom out: from the View window, or using the Shift+number keys, scale down from full size in the
same stages.

Using the mouse wheel, zooming in and out is smooth and unlimited.

To smooth the high-level zoom image, add antialiasing (View menu or shortcut key ‘a’).

Zoom panel

From the View menu, or key ‘z’, show where the zoomed area (green) is located in relation to the full
frame (grey). In any zoom selection, the movie frame can be dragged around in the viewer window
using the mouse.

This panel is resized with the up/down arrow keys.
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Info panel

This can be toggled on and off from the View menu, or the ‘i’ key. It shows the file properties and
frame-sequence position, and the current view settings. The frame count is not derived from
filenames, but represents the count within the current available sequence, starting at 0.

Pos: shows the coordinates of the top left frame pixel in the viewing window, and in brackets, the
coordinates of the mouse cursor within the media.

This panel is resized with the up/down arrow keys.

Background/transparency

To make it easier to see transparent areas of a frame or the frame edge, the background can be
switched from black to red: View > Show Transparency (Red Bg) or use the ‘t’ key toggle.

Installation (users pre Delta 2.6)

If you were previously provided with an earlier version of 7thMovieViewer, unzip the file on the PC on
which you want to view the files. Note: the zlib1.dll file is required to run 7thMovieViewer.

Version 1.0.6 of 7thMovieViewer had no scale and zoom, so shows less file information:

Movie and frame data are shown overlaid. Move through frames with the cursor keys, or scroll with
the lower scroll bar.





7thFileVerifier
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7thFileVerifier

Function of 7thFileVerifier

7thFileVerifier is an app that allows you to check a folder of movie frame files to test validity against
several variable parameters. These currently include:

· whether the file is a valid .7th file

· to perform a checksum on the files data and name

· check the file size remains constant throughout the whole folder

· check frames are sequential.

How to Use

Run 7thFileVerifier.exe.

1. There are several options to choose depending on the type of verification you would like to do
(multiple options can be chosen). These are explained in detail further into this guide.

2. Click ‘Open File Browser’ and go to the path of the folder containing the frames to be verified.

3. You will then see the application go through each file and output a message depending on what
has been found. 

As well as writing to the application window, a log file will also be created in the same directory as the
executable itself, called 7thFileVerificationLog.txt. This writes whatever would also be displayed in
the application window, so you can look at this to confirm the results, even after the application has
finished running.
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Options

Check for valid and consistent 7th File

This is defaulted to ticked when the application opens.

This option checks the file data header of each file for a valid .7th file format: it isn’t just checking the
file extension.

This option also checks consistency of the 7th files. For example, if the width, height or compression
of the files changes within the sequence, this will be highlighted.

If this option is not checked, then header information will not be checked. You can therefore check
other formats, such as TGA for sequential integrity or other options.

Perform checksum on file data and names

This option is defaulted to off.

Perform a checksum on the files’ data and name. An example usage would be to run this before and
after a file transfer, and verify that the checksum on each file is the same. If it is not, then you know
some corruption has occurred during transfer. An example output for one file would be:

7thFlyAnimationHD0000_00549.7th is good - v1 *** FileNameHash =
1bedf202fa8c0988820e0eed44163401 & FileDataHash = 72edd075c1489d3d85effa0c30699025

· The first section says that file 7thFlyAnimationHD0000_00549.7th is good. The v1 part indicates it
is a version 1 header, the other option is 2.

· FileNameHash – This is a checksum on the name of the file.

· FileDataHash – This is a checksum on the data within the file.

This operation will take some additional time, so it is recommended to be unticked if you don’t need
to test this.

Unattended Mode

If not in unattended mode, the application will stop and the background will go red to indicate a
problem file has been found. Click on ‘Continue checking …’ to resume checking beyond the bad
frame:
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In unattended mode the interface will continue verifying even when it encounters a bad frame. The
purpose here is that you can compare log files at some point afterwards and know that a problem
with all the files will be marked. The interface will not pause on the red state with this checkbox
ticked.

Check file size is constant

This option is defaulted on.

This option will compare the file size of each file being verified, against the first file in the folder, if
they are not the same then the file will be flagged as bad.

Check frame numbers are sequential

This is defaulted off.

This option checks the frame number increases by one compared with the previous file. If not, then
the file is flagged as bad.



Carving Media for Dome Displays
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Carving Media for Dome Displays

The more channels are used to display on a dome, the smaller proportion each channel needs to
project. When more than one server is being used, each does not need more than the slice(s) of
media required for its channel(s). To lighten server loads, we can carve each frame of the media
down to only that part needed for each channel, instead of full frames. 

Allowing for overlap and blend, carved frames will tolerate small positional changes from projector
maintenance. If projectors are substantially displaced, however, gaps may be introduced, requiring a
fresh carving of the media to be done.

To see the saving, compare the complete fisheye media frame with a 6-projector dome map (each
colour outline represents a channel’s coverage), if spread over several servers (e.g. three servers
controlling 2 channels each):

Media credit: NSC Creative

Carving is a process of re-recording each channel’s segment of the media in turn, to be run on this,
and only this, display arrangement.

This guide assumes that you have already set up your server network and aligned your
channels/projectors, and have the media available on your timeline ready to carve.
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Show Setup for Carving

Important

When sharing media across multiple servers, each controls its own channel(s). For media to be
carved effectively, the settings for each channel must be set according to the individual projection
requirements. If the projectors are subsequently moved, and are realigned, carved channels may
no longer overlap and blend correctly. In these circumstances, the media would have to be re-
carved with new channel settings.

The instructions show how to carve media on a Leader server then share across Leader/Follower
servers, using manual calibration. See the alternative instructions for Domes with Scalable Auto-
alignment .

Note: if the whole movie is too large to fit on the server disk in a single session, carve your media in
‘batches’ of files/frames.

Show Setup: DeltaGUI

Create a new show on your Leader server, where you will carve the media:

Click File > New and Select ‘Resources and Configuration’ and ‘Clear Background’ to clear down all
previous configurations.

Choose Display > Dome Mode.

If you are unfamiliar with working in Dome Mode (previously termed Frustum Mode in earlier
DeltaGUI versions), please refer to the Delta User Guide in the appropriate version for your system.

114

http://portal.7thsense.one/online-help/index.html?online_user_guides.html
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Channel Setup (Manual Alignment)

Follow the normal procedures for setting up your projector channels for Dome Mode (see the main
Delta User Guide). Click on the Defaults Wizard to set initial Dome Mode Defaults. If aligning manually,
the settings you use may come from a CAD 3D model.

Select ‘Force n Channels’ and the number of channels that you are using, and other settings, then
click ‘Apply’ and ‘Done’ to close.

When you have finished a manual alignment, with small adjustments in the Dome Mode Channel
panel, make a note of these final settings for each channel. Minor movements in projectors from
regular maintenance may again be made manually.

When you carve media to these configurations, the result will only apply to them, with a small
amount of tolerance. More substantial realignment may require re-carving of the media.
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Output Setup: Display Mode

Select ‘Output Channels’ and set the Display Mode to Matrix, to match your graphics card desktop: in
this case, Matrix Mode (2D Array) of 3 × 2. Matrix mode enables you to have a better view of the
channels on the Playback Window rather than seeing channel views all in a row.

Now drop your media onto your timeline. Fisheye media mapping mode is normally detected
automatically, but check in the timeline resource properties, Screen Location tab:
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Fisheye media in the Playback window will be now divided like this (same media as in the introduction
to this section):

Media credit: NSC Creative
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Carving the Media (Leader Server)

Please note: From 2020 7thSense deprecated the terms master and slave for the dependencies
between devices. We now refer throughout to ‘Leader’ and ‘Follower’ in our products.

To maintain functionality, both terminologies continue to work internally, but our documentation no
longer uses the former terms. Users of pre-2020 products will need to observe the equivalence and
continue to use the previous legacy terms.

Carving follows the normal method of recording. With the media active (enabled) in the Timeline,
click the red Record button (bottom-left in DeltaGUI), and configure the output for each channel, in
your movie drive:

If content is 3D, you will need two Jobs: once for each eye.

Apply the settings and click RECORD. This button will turn solid red  RECORDING  until complete. Click
again if you need to stop recording. The process can take some time.

SAVE your show file to maintain the channel settings and use them to project media accordingly
from each of the group of servers.

The process will have carved each media file (frame) into channel segments, distributed into
individual folders, one for each channel.

You MUST maintain all files/folders for efficient playback, but can now distribute the folders between
servers so, when played back from the Leader server, media will appear as if being shown from a
single server.

https://portal.7thsense.one/user-guides/M384-delta2_7-user-guide/record_a_show_or_carve_media.html?zoom_highlightsub=%22carving+media%22
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Autoalignment systems and multiple servers

Each server needs the same channel settings to be applied from the server used for show setup
and autoalignment. The precision of settings from auto-alignment will be much higher, so it is
better to carve media for just those channels controlled by each server, from each server in turn.
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Distribute Carved Media to Correct Servers

Start a new show on each server, and copy the original show file settings across to each, so that all
channel settings are available. (This is more efficient than setting up channels again manually on
each server, and enables servers to be swapped in and out more easily if required.)

On each server, activate only the channel(s) that it will use, e.g. 1 & 2; 3 & 4; 5 & 6 – for 6 channels
distributed among 3 servers – and check that the final channel settings are the same as from the
server used for the manual alignment.

Each server only requires the carved media for the channels it controls. Copy the relevant folders
from the carving server and refresh the resources in the destination server in DeltaGUI.

Drag the new, carved and channel-specific, movie resource(s) onto the timeline for each server, and
access the media properties. Here is the server controlling channels 1 and 2:

In this example, media carved for channel 2 has been assigned Channel mapping mode (not fisheye
now), and located in channel 2.
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The Playback window will now show just these 2 channels in the correct position. Each other server
maps its parts of the dome to display the whole, but now each server is only delivering a fraction of
the original media volume.
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Domes with Scalable Autoalignment

The process is mostly the same as for manually-aligned domes, but it is better to carve channel
media from the servers that control them.

Scalable Display Manager, Leader server

· Run Scalable Display Manager as normal.

· Get all settings correct so the dome is mapped.

· In the Perspective menu, click ‘Override Frustums’ and add 5 degrees to all angles: up, down, left
and right.

· Click ‘Update Calibration’.

Carving media in Delta, for each server

· Import Auto-alignment frustums, geometry and blends into DeltaGUI.

· Fisheye-map the Leader media properties in the Resource Editor > Screen Location tab.

· Disable auto-alignment geometry (and blends) in DeltaGUI (Preferences > Startup), to just leave
the over-scanned frustum data in the channel definitions (it will look very wrong on the dome!)

· Record out the timeline on each server to a new folder per channel, at the required resolution and
format (on the E:\ Movie Drive) as described above for any carving .

Reassemble carved media in DeltaGUI

Delete the fisheye media from the timeline (you may want to remove the original media as well, to
save drive space).

Drag the newly-sliced carved media onto the timeline, then channel-map (Resource Editor > Screen
Location tab) to match the frustums (separate eye channels, if 3D) as described here .

Re-enable ‘Use Autoalignment’ option in DeltaGUI (Preferences > Startup).

After subsequent realignments in Scalable

Next time you run Scalable, run as normal, but make sure that the ‘Override Frustum’ option remains
ticked on the perspective page, and click ‘Update Calibration’ again to take into account the new
camera location or projector movements (within the 10 degrees ‘padding’ that was added for overlap
allowance).

110
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Refresh in DeltaGUI

In Display > Dome Mode, refresh the AutoAlign in the Canvas panel:





Using Networked Movie Storage (NAS)
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Using Networked Movie Storage (NAS)

It is possible to render frames in DeltaServer from a network SMB (Server Message Block protocol)
storage share, rather than the local movie storage volume. DeltaServer cannot currently be pointed
directly at the \\share style path to that share though, and even if you letter-mount that SMB path and
set that as the movie drive in Delta, DeltaServer will still not correctly render the frames off that
remote storage. Please see below instructions for the only known method for making that work.

Please also note that this approach is generally intended for non-realtime frame rendering, such as
step-through preview, programming, or using the standard ‘Record’ tool to produce carves or show
recording. Playing back movies in realtime at the high bandwidths typically utilised in DeltaServer,
would require a very powerful and carefully-tuned NAS or SAN to guarantee high enough and
consistent enough throughput for successful buffering. Please contact us at info@7thsense.one if
realtime playback from network storage seems like the best approach for your application, and we
will be happy to discuss it.

Using a symbolic link for a NAS

Delta requires a physical drive reference – mapped network drives will not show up in DeltaGUI. Here
is how to address the NAS using a symbolic link (symlink).

Create a symbolic directory link on the server C:\ drive via the command prompt (right-click and run as
administrator):

mklink /D C:\movies \\[NAS IP\folder]

Example:

mklink /D C:\movies \\10.100.100.123\movies

meaning: ‘create a symbolic directory link between destination and target’ so that C:\movies
becomes an advanced shortcut to the actual destination. For the NAS target path, use its IP (or host
name) and the required folder.

The symbolic link acts as a redirect, so copying files and folders to C:\movies will place them instead
on the NAS in the designated folder.

Note: The ‘mklink /d C:\Movies’ command will fail if a C:\Movies folder (or previously-created
symbolic link) already exists at that ‘C:\Movies’ location. If so, before running mklink, you should
delete that in Windows Explorer, or run this command to delete:

if exist "C:\Movies" rmdir "C:\Movies" /s /q

Protected SMB shares

If a NAS is password protected, the following command must be added:

net use [drive_letter]: \\[NAS IP\folder] /user:[username] [password] /persistent=yes

mailto:info@7thsense.one
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BackPack Media Distribution

BackPack is a DeltaGUI application, used in a networked server environment, to distribute files and
folders to Delta Media Servers via the DeltaMonitor application resident on each server.

BackPack.exe can be found in C:\Program Files\7thSense\Delta\Utilities.

Ø For overall server backup and restore, see: Stack Backup and Restore. 

http://portal.7thsense.one/user-guides/MC255-managing-servers/index.html?sf_backup_restore.html
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Main Menu

Config and Media settings are stored in an .xml file, so need not be saved for future use. The server
filter being too dynamic, is not.

File

Quit
Quit BackPack (any pending jobs are lost, any In Progress jobs continue).

Media

Enumerate (Ctrl-E)
You can enumerate media on all servers or a single server. Note that this could take a long time
if there are many files or folders. Pressing Ctrl+E at any time enumerates on all servers, as
shown here:

Clear Sync & Delete Selections
Clear all tick boxes / pending jobs on Sync and Delete pages.

Cancel All Jobs
Cancel all In-Progress jobs on all servers.
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Config

Show Tooltips
Tooltips default is off: enable them here.

Set Filename Width
Set the width in pixels (default 350) of the filename area on the left for the source files.

Server/Media Highlighting
Adds a square orange marker to highlight the current (mouse-over) row when viewing lists of
servers or of media.

Servers > Show Non Fixed Servers
Default off – show servers on the Sync page which are not in the Fixed Server List (as
configured on the Config page).

Servers > Wait for Source Files before Rebuild
When you request Media > Enumerate > All Servers, if this option is ticked, the files / servers grid
on the Sync page is not rebuilt until the Source server’s files are sent back. This speeds up the
redrawing of the grid of tick-buttons.

Servers > Clear Missing Servers
Hide missing or disabled servers from the Sync page.
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Help

About
Show the version information for BackPack.
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Sync Page

A single Delta server is set as the Source server (or as a proxy to a network based source drive), with
its movies, images, codec movies and audio shown in columns below:

· Media Type icon:  Movie, Codec, Image or Audio.

· Filename (hover over here to see the full path to this file)

· Media Size (hover over here to see the actual number of bytes)

To the right are a series of columns, one for each server, with the server name shown vertically. The
list of servers is sorted by name, with non-active servers shown in grey:
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For each file / server location, there is an tick box / indication box to select.

Server Name

The server initially shows as the IP address only, then when the config data arrives, will change to the
server’s machine name. You can hover over the server name to see the IP Address.

While loading, there are 2 grey bars, the lower grey bar indicates waiting on the config data, the upper
grey bar indicates waiting on the file list. As the specific data arrives, the lines will disappear.

Note that the Waiting on Files indicator bar will be shown again if you use Media > Enumerate until
the fresh file list arrives, then it will disappear as before.

Toggle Rows / Columns

For each file row, there is a horizontal arrow button. This selects the whole row of tick
boxes (active servers only) for this file. Also, Ctrl-Click the button to view the Copy /
Delete / Clear dialog which will apply to the whole row.

When the cursor is over a row, the row is indicated with an orange row marker
on the left (switchable from main menu: Config > Server/Media Highlighting).

For each server column, there is a vertical arrow button. This selects the whole column of tick boxes
(active servers only) for this server. Also, Ctrl-Click the button to view the Copy / Delete / Clear dialog
which will apply to the whole column.

Other Areas

Source server name and IP Address shown:

Tooltip showing full path when hovering over filename:
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Tooltip showing number of bytes when hovering over file size:

Hovering over a red disk error indicator shows the error:

Tick Box States

Unticked state & no file present (note that background colour of the tick box is alternated to
you can follow rows along, there is no difference).

Non-active server: tick button is hidden.

Unticked state, with orange corner Files Present marker showing there are matching
filenames present on this server, but not a match in bytes compared to the source server.

Unticked state, with green corner Files Present marker showing there are matching
filenames present on this server, and a match in bytes compared to the source server.

Job Error state – hover over the red indicator to see the actual error.

Job Complete / Enumeration Pending state. Shows that the copy or delete action
completed, to see the finished state, this server needs Enumeration. 

Ticked / Copy Pending state. 

Ticked / Delete Pending state. 

In Progress state with orange bar graph indicating percentage of job complete. 
Press this to cancel the job. 
Note that all active copy processes (default is 8 in parallel) will complete before the cancel is
acknowledged.



127

MC256-9 Managing Media for Delta : User Guide 
 
                                                                                                       © 2024 7thSense

BackPack Media Distribution

In queue. Indicates that progress on an actioned tickbox is not  greater than 0%. Click to
cancel.

Default Tick Actions

Ticking an unticked button will default to Delete Pending if there are any files present, or Copy
Pending if there are no files present as shown on the corner Files Present indicator.

Unticking a ticked button will default to removing the Delete or Copy Pending state.

Select + Ctrl

Holding down Ctrl when clicking a grid tick button or row/column button offers a small dialog where
you can choose to Copy, Delete or Clear, regardless of the state of the Files Present indicator.

This means you can choose to re-copy over existing media or finish the copy of partial movies, or
Delete media which you know to be there, but which BackPack is not yet aware of. Note that to copy
over existing files, on the Sync confirmation dialog, you need to choose Overwrite Target Files.

Sync Page: Using Copy/Delete

Once configured (see Config Page  ), servers will automatically populate until the server set as
Source is found, at which point its files are shown in the left column, with file present indicators for
each server / file tick box.

You can tick a single tick box or use the horizontal / vertical arrow buttons to select a whole row or
column of tick boxes.

Ticking a tick box which has files present (orange or green corner indicator) adds the file on that

server to the Delete list and shows the red-minus Delete Pending state: .

Ticking a tick box which has no files present (no corner indicator) adds the file on that server to the

Copy list and shows the green-plus Copy Pending state: .

Press Sync. This pops up a confirmation dialog where you can see all the pending copy or delete jobs:

136
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In this dialog, all Copy jobs and all Delete jobs, with these columns:

Action
Copy or Delete

Size
File size, rounded to MB or GB

Type
The type of media

Target
The target server IP / Share / Path / Filename (if any) to copy or delete.

Source
The source server IP / Share / Path / Filename (if any) for a copy action.

Disk Space Warnings

Below this, any warnings will show (as illustrated above). This will show where there is insufficient
space on the designated disk for a media item to be copied.

Note that proceeding with the copy is allowed, which may fill up the disk. Also note that the warning
does not account for the size of any files in the queue which are to be deleted.
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Copy Mode

Copy Mode is one of two types:

Merge Source with Target Files
Only copy files to the target which are not already there.

Overwrite Target Files
Copy all files even if they exist on the target.

Press Clear List to clear all tick boxes and remove all jobs from this dialog.

Press GO to start the copy & delete process, note there is no further check, it starts immediately on
pressing GO and there is no Undo, though there is a cancel button for longer jobs.

You can Cancel the dialog at any time, jobs are left as they were, add or remove jobs by ticking the
tick boxes and then press Sync to check the job list again.

Once the GO button is pressed, each job will change from the red or green tick box to the Q button.
When the job starts copying, it will change to a blue cross with an orange bar graph indicator to the
right. This will increment as the job progresses until the job is complete, then the blue cross button
will disappear.

Note that jobs are done one at a time, with all others queued up, and quick jobs (single files or
deletes) will complete quickly after starting, with no bar graph shown.

Note that after a copy or delete, the files present indicators are set to Pending Enumeration state,
you would need to use the Media Menu – Enumerate (All Servers, or choose one) to ask that server
to update its list of media and send to BackPack, at which time the files present indicators will be
correct.

Delete and Sync Page: Filters

There may be many thousands of media assets and 40+ active servers all connected to BackPack, so
filters are necessary to find the subset of interesting media / servers to work on.

Press the Media Filter button to show the media filter dialog. 
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Filter Examples

Minimum File Size 100KB
1MB
12GB

Maximum File Size 3MB
10GB

Path Green
Green | Blue
Green & Blue

Name TestMovie  
TestMovie | TestAudio
Test & Audio

Extension 7th
TGA | 7TH

Media Type Movie, Codec, Image or Audio

Shares Any of the Own Shares for the server

To clear filters, remove the text from the box and choose ‘Any Media Type’ / ‘Any Share’ drop-down
selections. Pressing OK will apply these filters to the page and show only the subset of media
matching the filter criteria.

Press the Server Filter button to show the server filter dialog. This shows a list of servers (active and
non-active) and whether they are filtered out or not. To alter a single server, scroll it into view, then
choose the Filtered-Out status. You can press Select All or Clear to select / deselect all.
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Press OK to apply the server filters and hide servers marked as Filtered Out.

The active filters are shown in the filter box in orange when active:

Pressing the Sort button shows the Change Media Sorting dialog – you can choose to sort by Name,
Path, Extension or Media Type, in Ascending or Descending order. Default sorting is by Path,
Ascending:
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The chosen Sort Mode (if any) is shown in orange in the sort box when active:
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Delete Page

All servers can be previewed for available space by checking ‘Show Summary’:

Colour key

Purple: Source server

Blue: no disk space alerts

Orange: < 15% free space

Dark red: < 5% free space

Bright red: < 1% free space

This page shows all media for a selected server in a single list, with the server name and IP Address
shown in the purple bar, and its media listed below.

For each piece of media, the full path and filename is shown, then the number of files (movies have
multiple), then the file size and file date of the first file found in that folder:
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You can apply filters and sorting as before to show a subset of media in the desired order.

Ticking a tick box beside the filename adds it to the Delete list, and when you press the Delete button,
the confirmation dialog is shown as below.
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Press Go to start the delete process, Clear List to remove all ticked items and cancel to hide the
dialog.

Note: there is no further check after pressing GO.
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Config Page: Systems

On the Config > System page, use the Current Source dropdown to select the source server. Once you
press Save Config, the selected server is set as Source, all other servers are set as Targets, then the
config is sent down to all connected servers and stored in Config.xml, which is found in \Program
Files\7thSense\Delta\System.

On this page, you can set the global throttle from 1 to 100%. After clicking Save Config, the new global
throttle is set (and saved in Config.xml) on all servers. This works with the local server throttle value,
to set the overall rate at which media is downloaded to that server.

You can also set whether a target server will use a username and password to login to the Source
server. This global setting can be on or off, and you can set the username and password. In the
example below, the username is ‘7thSense Design Ltd’, with no password, which is the default.

Note: These 4 characters cannot be used in share passwords: * | ? : 
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Config: Servers Tab

There are two tables, one a Fixed Server List and the other a Non-Fixed Server List.

A server in the Fixed table will be shown in the Sync/Delete pages whether it has connected or not (it
is greyed out until connected). This allows you to have a known set of servers in the list even if they
have not yet appeared. 

All other servers not in the Fixed table will be shown in the Non-Fixed table as they come online – you
can move them into the fixed list as required, by selecting them in the Non-Fixed table, then clicking
Add to Fixed List (above the table). You can remove a fixed server from that list by selecting it and
clicking Remove (above the table).

Click Add Manually to add any IP address to the Fixed list.

Once you press Save Config, the Fixed List of servers will be saved to all servers (Config.XML), but
this list is only read from the Source server once it arrives.

In the table, the Media Source IP and MB/s (local server throttle) can be set for each server by clicking
in the MB/s box and editing its value.

Note that the Fixed List comes only from the Source server, so the Sync grid of tick boxes will not
show until the source server arrives. To see Non-Fixed servers any time, choose Menu > Config >
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Servers > Show Non Fixed Servers.

Media Source

A Source server will usually have the Media Source set to its own IP so that it finds media assets on
itself. However, to use a server as a Proxy to another server (or some other SAN / NAS), enter the
remote Media Source for that server. This can be an IP Address (10.0.1.223) or a DNS Name
(MyNAS), but bear in mind the network infrastructure must resolve the DNS Name to an IP for this to
work.

When a different Media Source to the server’s own IP is set, that server will show:
Server Name : Own IP Address (Src=Source IP Address).

examples:

10.0.1.200 : Delta Nano1 (Src=10.0.1.244)
10.0.1.200 : Delta Nano1 (Src=MyNAS)

When a server is used as a proxy, it will ignore its own media assets and enumerate from the Source
IP server, so this server must be active when DeltaMonitor starts or is asked to Enumerate from
BackPack’s Media menu. The Own Shares as described below should be set to shares that exist on
the Source IP server, as shares on the proxy server will be ignored.

See below for Share Aliases.

Shares

By clicking on any of the servers in the Fixed or Non-Fixed server lists, the Shares table is shown as
below.
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Share Information Panel

This panel displays the free disk space, sector bytes and any Windows System Error Codes (see
Microsoft: System Error Codes). Example: error 53 means network path not found, error 54 means
network busy. Note that for a share which is not there, inaccessible or spelled wrong in BackPack, it
will likely return one of a few different error codes, but they all indicate the same thing, that it can’t
access the share.

This share information is updated when you Save Config, when the server first arrives, and after an
enumeration of that server.

When DeltaMonitor starts, it enumerates (gathers a list) of media as found in the Share list, so for
example, on the 192.168.1.133 server, Media is arranged via Window Shares named like this:

\\192.168.1.133\Movie Drive\Movies\Common (Movie media)

\\192.168.1.133\Movie Drive\Movies\Codecs (Codec media)

\\192.168.1.133\Images (Image media)

\\192.168.1.133\Audio (Audio media)

When this server starts up, it works through these shares and finds relevant media types, then keeps
this is a list until BackPack requests it.

Note that the shares are entered by hand as below, so they must exist on the server for this to
function. You can check by using Windows Explorer with the IP Address / Share to see if it exists. If

https://docs.microsoft.com/en-gb/windows/win32/debug/system-error-codes--0-499-?redirectedfrom=MSDN
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you get no media or missing media, try Menu > Media > Enumerate (choose server), also check the
share exists and can be accessed without logging in with a username / password.

Add
Adds a share at the end (or after a selected share), then edit the media type and share location

Remove
Removes the selected share

Copy
Copy shares from another server.

This is only saved to servers after pressing Save Config.

Source Share Alias

If all servers share the same path structure, then comparing and copying / deleting files would work
without any aliases. However, it is common for differently configured devices to have a partially
different path structure so that it makes sense on the device. Aliases allow the target server file /
folder to be compared to the source server file / folder even if they have different share structures.

Example with identical structure (no alias required)

Source Server Source Share Source File Target Server Target Share Target File

192.168.1.100 \Movies\Common Animate_*.7TH 192.168.1.88 \Movies\Common Animate_*.7TH

192.168.1.100 \Images Colours\Blue.jpg 192.168.1.88 \Images Colours\Blue.jpg

192.168.1.100 \Audio Mp3s\loud.mp3 192.168.1.88 \Audio Mp3s\loud.mp3

Since the source and target shares match identically, the command to copy source onto target will
work without any aliases in the share.

Example with different structure (alias required)

Source Server Source Share Source File Target Server Target Share Target File

192.168.1.100 \Movies\Common Animate_*.7TH 192.168.1.88 \Movies_E\Common Animate_*.7TH

192.168.1.100 \Images Colours\Blue.jpg 192.168.1.88 \7thSense Data\Images Colours\Blue.jpg

192.168.1.100 \Audio Mp3s\loud.mp3 192.168.1.88 \7thSense Data\ Audio Mp3s\loud.mp3

Since the source and target shares do not match, but these files are the same, we need to tell
BackPack and the server about the differences. This is done by entering a Source Share Alias for
each share on the Target (non-Source) servers:
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Source Server 192.168.1.100 (note no Source Share alias required for Source server)

Media Own Share Source Share Alias

Movie \Movies\Common

Image \Images (

Audio \Audio

Target Server 192.168.1.88

Media Own Share Source Share Alias

Movie \Movies_E\Common \Movies\Common

Image \7thSense Data\Images % \Images

Audio \7thSense Data\ Audio \Audio

So now, the target server will enumerate its own media from its own shares and BackPack compares
against the source in its different shares:

Target Source

\\192.168.1.88\Movies_E\Common\Animate_*.7TH = \\192.168.1.100\Movies\Common\Animate_*.7TH

\\192.168.1.88\7thSense Data\Images\Colours\Blue.jpg = \\192.168.1.100\Images\Colours\Blue.jpg

\\192.168.1.88\7thSense Data\Audio\Mp3s\loud.mp3 = \\192.168.1.100\Audio\Mp3s\loud.mp3

Note that if the Source Share Alias is not correct or missing, the comparison for identifying if files are
present or not will fail and any Copy or Delete job will fail, since the source location will not match the
shares on the Source server.

In a system with one Source server (with different share structure to the Target servers) & multiple
Target servers (all the same), set the Source servers shares, then a single Target server’s shares and
aliases and use the Copy dialog to copy to a Target server:
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All shares and share aliases are stored locally on each server in Config.XML after you press Save
Config.

RAID7th

For Delta servers configured with a 7thSense-specific RAID7th drive configuration, movie files within
a single source folder are distributed on multiple separated drives within the server. These are not
accessible via a network share as normal, but by using a special placeholder within the share name to
indicate that files should be stored according to the RAID7th algorithm.

In order to configure RAID7th on a specific share, use the following {RAID7TH} syntax for the Own
Share on the server which has been configured for RAID7th (using the Delta GUI). Note you have to
restart Delta Monitor after making any changes to the RAID7th drive configuration in Delta GUI.

Example share mapping for RAID7th: 

Own Share:
\{RAID7TH}\Movies

Source Share Alias:
\Movies
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Note that if you omit the {RAID7TH} placeholder, BackPack will attempt to use a normal Windows
share to copy into, and if you omit a matching Source Share Alias, this is an incorrect configuration
and all files will be copied into a single folder, instead of using the RAID7th algorithm. Compare how
RAID7th disks are displayed for a server, with the RAID7th drive letters rather than drive shares:

RAID7th is only applicable to sequential Movie resources, so images, audio or codec movies should
not be configured for RAID7th.

Config: Logging Tab

The log table shows log entries for servers arriving, enumerating, disappearing and job status as it
arrives. 

Clear will clear the list.

Scroll List (if checked) will scroll the list to the most recent entry.
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Communication

DeltaMonitor will by default bind to any available IP/NIC on the server, but with multi-NIC setups, this
may be undesirable. In order to force DeltaMonitor to bind to a specific NIC, first configure the NIC
with the required IP address, then edit the C:\Program Files\7thSense\Delta\System\BackPack.xml
to have the UDP_BindIP field as that IP address.

<UDP_BindIP>10.0.1.123</UDP_BindIP>

You can also force this and other related comms parameters by using a comms.ini file, which should
be located in the same folder as DeltaMonitor.exe (\Delta\Utilities). Note that settings in comms.ini
override anything in BackPack.xml.

Sample comms.ini file
[UDP Discovery]
UDP port=9999
UDP Binding IP=10.0.1.123
UDP Broadcast interval=100
[ZMQ]
Port number=5553
Connection timeout=2000
ping connected time=1000
heartbeat check time=50
poll timeout=300

BackPack will find DeltaMonitor on any available NIC.

Bind IP / Media Source IP and Separating Networks

In complex setups, a faster network is used for the media transfer and a slower control network is
used for communication between BackPack and DeltaMonitor. This requires multiple NICs in each
server and the network setup so BackPack can see the control network.

Server Role Own Bind IP (DeltaMonitor)

Slow 1GB network

Media Source IP

Fast 10G network

Source (using a Proxy) 192.168.55.100 192.168.99.10 (separate NAS)

Target 192.168.55.101 192.168.99.101 (self)

Target 192.168.55.102 192.168.99.102 (self)

In this example, all servers have 2 x NICs, and each Target server views and copies files over the 10G
(192.168.99.x) network, but it communicates to BackPack over the 1G (192.168.55.x) network,
keeping control and media separate. The Source is setup as a source proxy, viewing a NAS on 10G at
192.168.99.10.
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General Notes

Throttles should be set so that the network is not saturated with traffic – if it is saturated, there is a
possibility that BackPack will temporarily lose connection to servers (in progress jobs are unaffected).
Using separate networks as above can help with this.

The Source server (or NAS via a proxy server) needs to allow many simultaneous network
connections, since asking 30 servers to copy media will result in at least 30 parallel connections to the
Source IP. Note that Windows 7 and 10 Professional are limited to 20 parallel SMB connections,
Windows Server is unlimited.
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Document Information
Date Document

edition
Software
version

Revision Details Author/Editor

July 2017 1 DFM 2.4.10, CPS 1.0,
7thMovieViewer 1.0.6

New release Andie Davidson

September 2018 2 DFM 2.4.10, CPS 1.0
7thMovieViewer 1.0.6

Updated. Linking to a
NAS

Andie Davidson

February 2019 3 DFM 2.4.13, CPS 1.0
Nuke Reader/Writer Plugin v.1.1
7thMovieViewer 1.0.11
BackPack 1.0.17

Nuke Reader/Writer
Plugin and
7thMovieViewer
updated

Andie Davidson

December 2019 4 DFM 2.4.13,
Nuke Reader/Writer Plugin v.1.1
AfterEffects CC 2019 v.1.0

Updates for DFM
and running
AfterEffects CC2019
on Mac OS
Clarification of NAS
usage

Andie Davidson

July 2020 5 DFM 2.4.13,
AfterEffects CC 2019 v.1.0-2

Revised server
terminology

Andie Davidson

April 2021 6 DFM 2.4.13,
Nuke7th Plugin v.2
AdobeMediaCore7th plugin v.1.0

Addition of
AdobeMediaCore
and Nuke plugins

Andie Davidson

May 2023 7 DFM 2.4.13,
Nuke7th Plugin v.2
AdobeMediaCore7th plugin v.1.1.1

Datapath DP capture
resolution
monitoring tip added.
AdobeMediaCore7th
plugin v.1.1.1
resource upgrade

Andie Davidson

May 2024 8 DFM 2.4.13,
Nuke7th Plugin v.2
AdobeMediaCore7th plugin v.1.1.1

NotchLC to
NotchLC7th
conversion utility
added

Andie Davidson

June 2024 9 DFM 2.4.13,
Nuke7th Plugin v.2.2.1
AdobeMediaCore7th plugin v.1.1.1

Nuke plugin and
downloads updated

Andie Davidson
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